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The purpose of this product description is to enable the customer to satisfy himself as to 
whether or not the product or service would be suitable for his needs. All previous product 
descriptions for this product or service are superseded by this document. Acceptance of any 
order placed is in accordance with the content of the latest product description at the time the 
order is placed. As it is Travsys's policy to continue to develop and to improve its products and 
services, customers are advised to contact their Travsys representative to ensure that they are 
in possession of the latest product description concerning the product or service. This product 
description is valid in terms of the data shown below.  Certain of the facilities referred to in 
this Product Description may be Diagnostic Materials (including diagnostic and test routines, 
programs, manuals, documentation, and data) incorporated solely for use by Travsys and/or 
the Customer, but only as authorised by Travsys.  Travsys reserves the right to change or 
withdraw such facilities.  
 
 

Comms Client Pro for Windows 
 
Product Identity 
 
Order code: 010015 

 Comms Client Pro for Windows 
 
Outline Description 
 
Comms Client Pro (CCP) for Windows* software provides terminal emulation facilities to the 
agent and all airline specific printer handling. The agent can select various airline systems 
to work with through a single user interface.  
 

The agents are able to enter into a dialogue with the remote host using the natural 
command syntax of the host system. Once completed, the agent will be able to sign out of 
the host manually. Multiple airline communication windows can be active at the same time. 
The agent selects the airline to work with by activating that particular window. 
 

A scripting facility, called ABLE, can be used to provide user interface features. This 
scripting facility provides the development capability required to build or use an existing 
"FrontEnd" for the host services to simplify training and useage. 
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CCP supports devices necessary for document processing, namely Boarding Pass Printers 
(BPP), Bag Tag Printers (BTP), CC readers, Passport OCR readers, ATB Printers, and 
Document Printers. Support for the use of directly connected printers or remote printers 
(e.g. connected to another nearby workstation) is provided. 
 

Comms Client Pro for Windows contains the following components: 
 

• Sessions controller 
• Macro/script editor 
• Dialog box editor 
 

Principal Features 
Screen Layout  
The CCP for Windows is an MDI (Multi Document Interface) application. The application 
frame window has a title bar, a menu bar, a toolbar, and a status line. Each airline host 
session is contained within the CCP application frame window. Each host session has its 
own window that has a title bar and status line. The Session status line indicates the 
communication line status, the cursor position, etc. Depending on the protocol, host 
session windows can be split into 2 or 4 panes, all sharing the same address. 

 
Figure 1: The main screen of the CCP for Windows application is shown with four panes 
open in a session window. The major screen elements are described. 
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Screen Menu and Button Functions 
All the functionality of the CCP for Windows application is driven via the screen menu bar 
(and optional tool bar), which provides pull- down menu options and buttons. The normal 
Windows GUI type interface is provided so that each facility can be accessed through an 
appropriate combination of keystrokes or through the use of a mouse (if connected to the 
workstation).  
 
Status Lines (Frame and Host Sessions) 
As outlined above, two types of status lines are displayed on the screen: a global status line 
for the main window and a status line for each host session window. The frame status line 
contains the following information: 
 

Help Text  (short help text explaining the current selected menu command) 
Cap Lock indicator 
Num Lock indicator 
Scroll Lock indicator 
 

A consistent host status line format is provided which is independent of the underlying host 
communication protocol. It contains the following information: 
 

Active pane number (a number between 1 and 4) 
 
Communication line status  
 ON LINE The communication line is active 
 NO POLL No polls received for at least 20 sec. 
 NO DATA No data activity on the communication line at all 
 NO DCD No Data Carrier Detect signal from the modem 
 NO DSR No Data Set Ready signal from the modem 
 COM 597 Connection lost with the communication server 
 COM 599 New connection with the server to be established 
 
Keyboard lock 
 X SYSTEM Message submitted for transmission 
 X WAIT Message send to the host system, waiting for response 
 X NO SOM No Start Of Message where a SOM was required 
 
Printer status 
 PBUSY  Printer busy with other print request 
 PRINT  Printer printing 
 PBAD  Printer malfunctioning 
 
Cursor position (row and column position) 
 
UMSG indicator (set when an UMSG message is received) 
 
PUSH RPT indicator (set when a message with an error is received) 
 
RE-ENTER indicator (set when a RE-ENTER message is received) 
 
Free text field (is used for general information such as the name of airline) 
 
Host Commands (Entry and Response) 
Within a host session window, commands can be entered by the check-in agent and 
submitted to the host. These commands can be entered as the native commands of the 
airline host.  
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ALC/CPARS Hosts (normal messages) 
With ALC/CPARS host session, command entry should start after the SOM symbol (>). 
Pressing the ENTER key sends all the data between the SOM and the cursor (not including 
the cursor location) to the airline host via the appropriate communication server.  
 

Output data from the host is transmitted back to the host session, having been checked 
within the communication server for transmission errors. This data is displayed according 
to the host control sequences embedded within the response. If a CCC error were to be 
detected, the PUSH RPT indicator is displayed on the session status line and is cleared 
when the REPEAT key is pressed. 
 
ALC/CPARS Hosts (broadcast messages) 
If the airline host or the communication network issues a broadcast message that is 
destined for the client workstation, the broadcast message appears at the broadcast 
message area at the bottom of the frame window. This message is erased when the ‘Clear’ 
key is pressed 
If the airline host or the communication network issues a UMSG message, the UMSG 
indicator is displayed at the host status line. This indicator is cleared when the UMSG 
function key is pressed. 
 

Similarly, if the airline host or the communication network issues a RE-ENTER message, 
the RE-ENTER indicator is displayed at the host status line. This indicator is removed when 
the next message in transmitted. 
 
UTS Hosts (normal messages) 
With a UTS host session, command entry should start after the SOM symbol (>) or at the 
home position (top left corner) on the window. Once complete, pressing the ENTER key will 
send all data between the SOM or the home position and the cursor, including the 
character at the cursor location to the airline host via the communication server. 
 

Output data from the host is transmitted back to the host session, having been checked 
within the communication server for transmission errors. This data is displayed according 
to the host control sequences embedded within the response. 
 
UTS Hosts (broadcast messages) 
If the airline host or the communication network issues a broadcast message, which is 
destined for the client, the broadcast message will appear at the broadcast message are at 
the bottom of the window. This message is erased when the ‘Clear’ key is pressed 
 

If the airline host or the communication network issues a UMSG message, then UMSG 
indicator is displayed at the host status line. This indicator is cleared when the UMSG 
function key is pressed. 
 
Keyboard Functions 
Specific keys on the keyboard have specific functions associated with them. Whilst the 
actual key on the keyboard is dependant on the keyboard mapping, each function whether 
it be common across all host protocols or specific to a particular protocol, can be given a 
symbolic name.  
 
Re-mapping 
A keyboard re-mapping function redefines the keyboard layout and assigns simple strings 
to function keys. It is also possible to assign menu functions and macro scripts to single 
keys. This function is provided as part of the ‘Options’ menu. The settings are stored in the 
check-in agents network server user directory, and the current settings are restored on the 
workstation each time the user signs on. 
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Figure 2: The Keyboard Remap dialog box is shown after the function is first enabled. 
 
Online Help 
To assist the agent, a help facility is available. It is possible to access on line help by 
pressing F1 to get context-sensitive help, using the the help button on the Toolbar to open 
the Help Contents window, using the Help menu, and by pressing the Help button in any of 
the dialog boxes. 
 

 
Figure 3: The CCP Help facility Main Index is shown after the function is first enabled. 

This help facility conforms to the standard Windows help layout by providing the following 
facilities: - 
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Contents 
Shows the major components on the Main Index page.  
 

Back 
Used to backstep through the help topics that were most recently accessed. 
 

History 
A complete sequential list of every help topic viewed during the current Windows session. 
 

Index 
Contains an alphabetical list of all the Help topics. 
 

Browse 
The << >> buttons are used to access the next or previous topic in a series of related topics. 
 

Search 
The search feature is used to see a specific topic. The search feature can be accessed by 
selecting Search for Help on... in the Help menu or by choosing the Search button in the 
Help facility. 
 

Glossary 
The glossary feature is used to look up the definition of a specific term. The glossary feature 
can be accessed by selecting Glossary in the Help contents or by choosing the Glossary 
button. 
 

Display Help While You Work 
The Help window can be displayed while the application is active by selecting Always on top 
in the Help menu of the Help window. The Help window can be moved and/or resized if it 
covers a part of the application that is being worked on.  
 

Jumping Around 
The Help program will allow moving around the various help topics by “jumping”. When the 
mouse pointer passes over a graphics area that is tied to more information, the pointer 
changes to a small hand. Hypertext is indicated by a different colour. 
 
Printing A Help Topic 
Any topic in the Help facility can be printed by selecting ‘Print Topic’ from the File menu in 
the Help window. 
 
Calculator 
The calculator is one of the tools provided in CCP. 

 
Figure 4: The Calculator is shown after the function is first enabled. 
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Calendar 
The calendar is one of the tools provided in CCP. 
 

 
Figure 5: The Calendar is shown after the function is first enabled. 

 
Printer Support 
Part of the agent’s normal work involves the use of a variety of different printers. CCP 
supports a number of printer types, either connected directly to the client workstation or, 
by use of the printer server functionality, those connected on another client workstation 
(preferably one nearby).  
 

Configuration data defines the default printer configuration for each workstation, although 
each check-in agent is able to select an alternative via the applications menus and toolbars. 
 

The following printers are supported: - 
 
Document printers 
Any Windows supported printer 
Baggage Tag Printers  
Boarding Pass Printers 
ATB Printers 
 
The printers are driven as per request received from the airline host during the processing 
of check-in transactions. Whilst a locking mechanism is utilised to minimise the 
intermixing of different client workstation ‘printouts’ when a printer is being ‘shared’, this 
can only be achieved to a level of granularity allowed by the host airline printing protocols. 
 
Script Facility 
 
Overview 
The scripting facility is compatible with Microsoft’s Visual Basic and has been extended to 
provide the additional scripting features necessary for use within the CCP for Windows 
application. The core product provides a number of development components, namely an 
editor, script compiler, debugger and dialog editor. 
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CCP for Windows Configuration 
Client configuration can be divided in the following sections: 
 

Hardware dependant configuration per workstation 
 Printer configuration parameters 
  Printer Server Name 
  Print speed 
  Printer protocol 
 Logical printer ID’s 
  First boarding pass printer 
  Alternative boarding pass printer 
  First baggage tag printer 
  Alternative baggage tag printer 
 

User dependant configuration (in the users own directory) 
 Presentation parameters 
  Font 
  Window layout 
 Keyboard re-map tables 
 Authorisation level settings 
 

Airline dependant configuration (in a global emulator directory) 
 Session name (pool) 
 Auto-run script 
 

A configuration application is provided to create and modify each part of this client 
configuration.  
 

As soon as a new user is configured the default configuration files need to be copied into 
the users home directory. 
 

CCP Main Screen Functions 

Sessions 

Create a new session, open a session, and save the current session. 
 
Editing 

Cut, copy, and paste the current selection. 
 
Extended Services 

CCP extended services include the calculator, the calendar, the macro editor, access to the 
relevant Control Page, and access to a local printer. 
 
Utilities 

CCP utilities include keyboard remaping, colour selection, font selection, the help program, 
and context sensitive help. 
 

ABLE Functions 

Macros 

Create a blank macro, open a macro, save current macro to disk, and save current macro 
to disk with a new name. 
 
Editing 
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Copy, cut, and paste the current selection, undo, find text, find next occurrence of last text 
searched for, find and replace text, and invoke the Dialog Editor to edit an ABLE dialog box. 
 
Testing 

Check the syntax, execute, and pause the executing program, activate the debugger, set 
and toggle a break-point on the current line, and stop executing the current program.  
 
Debugging 

The ABLE debugging facility allows the user to scroll to next or previous error returned 
from a syntax check, step into, over, or out of the current procedure in the debugger, and 
stop executing the debugging session. 
 
Utilities 

ABLE utilities include the Console window, the Variable window, and extensive help. 
 
Dialog Editor 

Dialog Box Design 

Create, open and save the current dialog box to disk. 
 
Editing 

Cut, copy, and paste the current selection and to align controls; make all controls same 
width and/or height; and center controls vertically and horizontally in the dialog box. 
 
Controls 

Select one or a group of controls, label controls that do not have a visible label, visually 
group controls, create option buttons, push buttons, check boxes, input areas, bitmaps, 
and present a list of strings. 
 
Utilities 

The ABLE dialog box editor utilities include the Options box, a code window, grid (toggle on 
and off) and extensive help text. 
 
Security 

Most functions can be enabled/disabled on a user basis. 
 
Error and Status Messages 
 
CCP can display the following types of message: 
 
• Status messages are displayed at the status bar 
• Warnings are shown at the status bar and may be accompanied by a short beep 
• Errors are indicated at the status bar or in a dialogue box 
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Hardware and Software Prerequisites 
 
• IBM Pentium PC or compatible 
• Processing speed: 100 MHz or higher 
• 4 MB RAM 
• 3.5 MB Free Hard Disk space 
• Windows 2000. or Windows XP 
• Keyboard and Mouse 
• A TCP/IP network connection to connect to the CSPNT Server or to a MATIP Server 
 
 
Trademarks 
 
• CSPNT and CCP are trademarks of Travsys BV 
• Windows is a registered trademark of Microsoft Corporation. 
• All other trademarks are the property of their respective owners 
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